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EDITING IN MS WORD (365) 101 
 

Instructor: Rachel E. Newman 
 
 

LESSON #1 
Editing with Track Changes and Comments 

 
 
This class is geared toward the beginning user. I designed it to be a practical, hands-on 
experience that gets you right into editing with Microsoft Word (“Word”) from the get-go. I want 
to make sure that learning the features offered in Word is not an intimidating experience for any 
of you. Having said that, there is a lot of text in each lesson, so just read through the lessons 
slowly and take them step-by-step. As you go through each week’s lesson, if you see a way it 
could be improved, please make a note of it. At the end of the course, you’ll have a chance to 
give feedback so I can make the course even better next year. Also, if you catch any 
proofreading errors, please share them with me.  
 
Let’s begin. 
 
We will be using Microsoft Word for Microsoft 365, the most updated version of Word. Many of 
the commands we talk about will be similar in previous versions, so if you don’t have Microsoft 
365, you will still benefit from these instructions. If you are using a Mac, the ⌘ (Command) 
key should be equivalent to the Ctrl key for Windows, and the Option key should be equivalent 
to the Alt key in Windows. If you have trouble, just let me know, and I’ll help you figure out 
how to navigate the version you have. Some of the features in Word for Microsoft 365 won’t be 
available in previous versions, and knowing what those are may help you decide whether it’s 
time to upgrade your version of MS Word. 
 
Let’s start by familiarizing yourself with the Home tab. Go ahead and open Word on your 
computer. Along the top, you will see several labels we call “tabs.” These are File, Home, Insert, 
Draw, Design, Layout, References, Mailings, Review, View, Developer, and Help. 
 
When you first open Word, “Home” will be selected and should have a thick blue line under it. 
Below the selected tab you will see what is called the “ribbon.” The ribbon contains all the 
commands you may have found under a drop-down menu in previous versions of Word. To the 
far right and at the bottom of the ribbon is an up-arrow symbol: . If you click on this arrow, 
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it will hide the ribbon. To show the ribbon again, click on one of the tabs. You’ll see the arrow 
has been replaced by a pushpin icon. If you click on this symbol, it will “pin” the ribbon so it is 
no longer hidden.  
 
The Home-tab ribbon has your commands for the clipboard, font, paragraph, styles, and some 
limited editing options.  
 

 
 
If you hover your cursor over the various buttons, you’ll notice that many of them have a 
keystroke command that can be used to apply that attribute to the text without having to move 
your hand to the mouse.  
 

  
 
Using keystrokes can save your wrists the fatigue of the repetitive motion of using the mouse. It 
also can save time. A couple of seconds doesn’t seem like much on their own, but as you get 
used to using keystrokes instead of the mouse, you’ll find you edit documents noticeably faster 
than you used to. It takes some dedication and patience to get used to using the keyboard. So as 
you work through this course, consider if it’s worth it to you to invest the time and energy now to 
save you time and energy for years to come. 
 
Another feature I want you to note right away is the ruler. There’s one along the top of your 
manuscript page and one along the far left side of the Microsoft Word window. These rulers 
control your margins, and the ruler along the top also controls your indents and your tab stops.  
 
You have three indent controls (see image below): 
 
 First Line Indent (red arrow) 
 Left Indent (green arrow) 
 Right Indent (blue arrow) 
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These indent controls can be manipulated by clicking and dragging (holding your mouse button 
down while dragging). You’ll notice a little rectangle under the left indent triangle. If you click 
and drag the rectangle, it will move the left indent and the first line indent together. If you click 
and drag only the triangle of the left indent, it will move only the left indent. 
 
The pink arrows point to tab stops. A tab stop marks the location the cursor will stop after you 
press the Tab key. You can use this feature to line up several lines of text by pressing the Tab 
key. To add a tab stop, click on the ruler. To remove the tab stop, click and drag the tab stop 
down off of the ruler. It’s been my experience that publishers generally want tab stops removed 
from manuscripts because they can mess things up during the final formatting stage. 
 
Before we go any further, let’s take care of a little housekeeping. 
 
 
Saving a Document 
The first thing I advise you do after opening your client’s manuscript is to save it with another 
name. Somewhere in the document name, indicate that this draft is an edited version and which 
version it is. I like to do that by adding my initials and the date (yymmdd) to the end of the file 
name (e.g., ClientFile_ren_200504). Avoid using periods in your file name. These can corrupt 
the file.  
 
There are two ways to save the document with another name: 
 
The Long Way: Click on the “File” tab in the upper left-hand corner. Select Save As. This gives 
you several options:  
 

 
You’ll notice on your computer that the default option is “OneDrive.” OneDrive is a file-hosting 
service provided by Microsoft. It allows you to store your files online so you can access them 
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from a web browser or mobile device. You can also sync and share your files with others. If you 
save to OneDrive, your files are stored on Microsoft’s server, and you can access them even if 
your personal computer goes down. If, however, your internet service is unreachable, it may 
cause problems in accessing your files on OneDrive. 
 
My personal preference is to save my files to my local computer hard drive (“This PC”). I back 
up my files once a week onto an external storage device. The disadvantage of saving files this 
way is that if my computer crashes, I lose anything that hasn’t been backed up yet.  
 
If you select the option “Browse,” you can navigate through the different folders on your 
computer and select where to save the document. 
 
The Short Way: Press F12. This will open the Save As “Browse” window. From here you can 
select the location to save the document. 
 
 
Creating a Backup 
If you choose to save your files to your local computer hard drive, I strongly recommend you 
turn on the option to always create a backup copy of your documents. To do this, click on the 
“File” tab in the upper left-hand corner. Select the very last item on the list, “Options.” 
 
Choose “Advanced” on the left side of the dialog box and then scroll down to the Save section. 
Make sure there is a checkmark in the “Always create backup copy.” This will save a backup 
copy in the same file location as your main copy, but it will add “Backup of” to the beginning of 
the name of the backup file. 
 

 
 
 
Track Changes 
Once the document is saved, you can jump right into editing. But first, you need to turn on Track 
Changes. Track Changes is an invaluable tool for our trade. You need to understand how to use it 
yourself and also how to give instructions to your clients on how to use it once you return the 
manuscript to them.  
 
There are two ways to toggle Track Changes on and off: 
 
The Long Way: Click on the Review tab.  
 
Then click on the paper-and-pen icon on the Track Changes button. 
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The Short Way: Press Ctrl + Shift + E. 
 
Now you can edit the document, and Microsoft Word will track each change you make. This 
allows your clients to review the changes and choose to accept or reject them. 
 
To the right of the Track Changes button is a drop-down box showing “All Markup.” If you click 
on the drop-down arrow you will see this list: 
 

 
 
Each of these options will change what you can see on the open document.  
 
Simple Markup will show a vertical line on the side of your page next to the lines that contain a 
change (although the marked change itself will not be visible). Simple Markup will also show 
your comment balloons. 
 
All Markup will show all the marked changes you have made to the original document. 
 
No Markup will show a final version of the document as it will look after all your changes have 
been accepted. 
 
Original will show the original document before you made any changes. 
 
The two options you will use the most are Simple Markup and All Markup. You can toggle 
between these two using the drop-down menu. Or you can use the shortcut option, which is to 
click on the vertical line next to any line in which you’ve made a change. If you click on the gray 
vertical line while in All Markup, it will show you what the document will look like once the 
changes are accepted. This is a great way to catch stray periods and extra spaces. 
 



Editing in MS Word 101, Newman | 6 
© 2020 The PEN Institute. All rights reserved. Reproduction or redistribution, all or part, is prohibited. 

 
 
When I edit, I usually remain in Simple Markup the majority of the time. But if I need to see 
what I’ve changed, deleted, or moved, I quickly move into All Markup mode by clicking on this 
vertical line. 
 
Back to your Review ribbon now. To the right of the Tracking section is the Changes section. 
Here you can accept or reject changes and cycle through changes using the Previous and Next 
buttons. The Accept and Reject buttons have drop-down menus that give you more specific 
options. 
 

 
 
You can accept or reject specific changes by selecting an area of text (single or multiple changes 
can be present within the text) and then clicking on “Accept” or “Reject.” Microsoft Word will 
automatically move the cursor to the next change after performing your command.  
 
If you’d like the cursor to remain in place, use the drop-down menu to click on “Accept This 
Change.” When you do that, Microsoft Word will accept the change and leave the cursor where 
it is. 
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You can see that one of the options on the drop-down menu is “Accept All Changes.” In my final 
letter to my clients, I instruct them to first go through and reject the changes they don’t want to 
keep since there should be significantly fewer changes that they disagree with than changes they 
want to accept. Once they’ve rejected the changes they want to reject, they can use this option on 
the drop-down menu to accept the rest of the changes in the document all at once. 
 
 
Comment Balloons 
Some changes you make will not require any explanation for your client. This includes most of 
your mechanical editing (punctuation, usage, spelling, hyphenation, capitalization, treatment of 
numbers, etc.). But some of your changes may need to be explained to your client. If you make a 
change that you think your client will question, or if the explanation of the change will help your 
client grow as an author, use a comment balloon to explain why you made the change. 
Depending on the client, I will even include references to CMOS (Chicago Manual of Style) and 
CWMS (Christian Writer’s Manual of Style) in my comments to reinforce my recommendations. 
 
Comments attach themselves to the text with a horizontal line. So you want to select the text that 
corresponds to the comment before you add the comment. 
 

 
 
There is a short and a long way to add comments to a manuscript (imagine that!).  
 
The Long Way: Click on the Review tab. In the Comments section, select “New Comment.” 
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The Short Way: Press Ctrl + Alt + M. (To return to the text, press your Esc key.) 
 
Once you add a comment balloon, you’ll notice two options at the bottom of the balloon: Reply 
and Resolve. This is a nice feature Microsoft Word for Microsoft 365 provides. You can hold a 
conversation with your client in a continuous comment balloon by clicking on “Reply.” Once the 
comment balloon has been addressed, you or your client can select “Resolve” and the comment 
balloon will become gray (inactive). 
 
At some point you will add a comment and later realize that you need to delete it. There are three 
ways to do this: 
 

1. Click within the comment balloon that needs to be deleted. Click on the Review tab. In 
the Comments area select “Delete.” 
 

2. Right-click on the comment balloon that needs to be 
deleted. On the pop-up menu that appears, select 
“Delete Comment.” 
 

3. With your cursor inside the comment balloon, press the 
menu key on your keyboard (not all keyboards have 
this feature). Press Shift + D. 

 
 
Conclusion 
This concludes this week’s lesson. I’ve provided several optional assignments to help you 
become familiar and comfortable with the information we’ve covered in this lesson. You don’t 
have to do the assignments, but like with anything, you’ll get out of this course what you put into 
it. Remember, if you want to receive a certificate of completion at the end of the course, you’ll 
need to complete at least two assignments for each lesson. 
 
 
 

* * * 
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LESSON #1 ASSIGNMENTS 
 
To receive a Certificate of Completion, you must successfully complete a designated number of 
assignments per lesson. For this lesson, you must complete all four assignments.  
 
For the following assignments, we will be working with the attached Microsoft Word document. 
This is a scene extracted from the middle of my current work in progress, a Christian YA fantasy 
novel. I’ve gone through and made sure there is plenty for you to mark and comment on. Please 
post your responses and upload your Microsoft Word document to the class Google Group. 
 
Assignment #1 
Open the attached document. Save the document with your preferred naming scheme in the 
appropriate location. Turn on Microsoft Word’s option to always create a backup copy. Tell the 
class about your experience. 

 
Assignment #2 
Turn on Track Changes and make changes to the document. Practice using the vertical line on 
the side to toggle between Simple Markup and All Markup. Tell the class about your experience. 

 
Assignment #3 
Add several comments to the attached document as if you were communicating with a client. 
Delete some of the comment balloons. Tell the class about your experience. 
 
Assignment #4 
Cycle through the changes you’ve made in the document using the Previous and Next buttons. 
Accept some changes, reject some changes, and leave some changes alone. Now try selecting 
specific text that has been changed. Accept or reject the change(s). Find an entire word that has 
been changed. Select only one letter of the word, accept or reject the change, and see how Word 
behaves. Tell the class about your experience. 
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